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POPIS KRATICA 

AMPK  adenozin monofosfat-kinaza (engl. adenosine monophosphate-activated protein 

kinase) 

BBB  krvno-moždana barijera (engl. blood-brain barrier) 

BSA  goveđi serum (engl. bovine serum albumin) 

CDC  Centar za kontrolu i prevenciju bolesti (engl. Center for Disease Control and 

Prevention) 

cGMP  ciklički gvanozin-monofosfat (engl. cyclic guanosine monophosphate) 

CNS  središnji živčani sustav (engl. central neurvous system) 

CYP  citokrom P450 (engl. cytochrome P450) 

DAB  diaminobenzidin (engl. 3,3´-diaminobenzidine) 

GFAP  glijalni fibrilarni kiseli protein (engl. glial fibrillary acidic protein) 

GPCR  obitelji receptora vezanih s G proteinima (engl. G protein-coupled receptors) 

IDV  vrijednost integrirane gustoće (engl. integrated density value) 

IP3  inozitol 1,4,5-trisfosfat (engl. inositol 1,4,5-trisphosphate) 

NeuN  neuronski jezgrin protein (engl. neuronal nuclear protein) 

Np55  neuroplastin 55 (engl. neuroplastin 55) 

Np65  neuroplastin 65 (engl. neuroplastin 65) 

PBS  fosfatni pufer (engl. phosphate buffered saline) 

PKC  protein kinaza C (engl. protein kinase C) 

PLC  fosfolipaza C (engl. phospholipase C) 

SNR  supstancija nigra (engl. substantia nigra) 
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1. UVOD 

1.1. Histamin 

 Histamin je kemijski glasnik koji se sintetizira iz aminokiseline histidina pomoću L-

histidin dekarboksilaze, enzima izraženog u različitim tipovima stanica (1). Važan je 

neurotransmiter središnjeg živčanog sustava (engl. central neurvous system, CNS) kralježnjaka, 

koji regulira različite centralne odgovore i funkcije, kao što su budnost, hranjenje, pijenje, 

neuroendokrini sustav, tjelesnu temperaturu, analgeziju i motoričku aktivnost (2). Javlja se u 

stanicama neuroepitelnog i hematopoetskog podrijetla te također služi za: izlučivanje želučane 

kiseline, imunomodulaciju, kontrakciju glatkih mišića (bronha), vazodilataciju, kao i kontrolu 

epitelne i endotelne barijere. Stoga ima važne implikacije na gastrointestinalne, imunološke, 

kardiovaskularne i reproduktivne funkcije (3). Također, histaminska signalizacija kontrolira 

nagon za konzumiranje hrane tako što ga smanjuje. Nedavni radovi pokazali su da histamin 

može imati važnu ulogu i u nenormalnim apetitima, ne samo za hranu već i za tvari zlouporabe 

(4). Mnogo je studija koje su se bavile histaminergičkim mehanizmima signalizacije u 

staničnim linijama podrijetlom iz tumora mozga. Eksperimenti na tumorima mozga prikazuju i 

H1 i H2 receptore te povećanu histaminsku propusnost u tumorima i u susjednim područjima. 

Međutim, uloga histamina u normalnom razvoju moždanih struktura, proliferaciji i 

diferencijaciji neurona i glijalnih stanica te rastu malignih tumora još uvijek je slabo shvaćena. 

Histamin je također jedan od čimbenika koji reguliraju protok krvi u tumorima mozga. Stoga 

je moguće da ovi mehanizmi doprinose rastu i razvoju tumora mozga (5). 

Histaminergični neuroni nalaze se u hipotalamičkoj tuberomamilarnoj jezgri, skupini 

magnocelularnih neurona koji se nalaze u stražnjoj i ventralnoj regiji hipotalamusa, u 

neposrednoj blizini stražnjeg udubljenja trećeg ventrikula (2, 6). Iz ove jezgre šalju se difuzne 

projekcije u gotovo sve regije mozga (2). Histaminergični aksoni inerviraju mnoga područja 

mozga, od prefrontalnog korteksa do leđne moždine, putem metabotropnih receptora H1, H2 i 

H3 koji u konačnici dovode ili do ekscitacije postsinaptičkih neurona ili modulacije njihovih 

neurotransmiterskih odgovora (6). Tri (H1, H2 i H3) od četiri histaminska receptora široko su 

rasprostranjeni u CNS-u. Postsinaptički smješteni H1 i H2 receptori aktiviraju nizvodne 

signalne putove; H1 receptor aktivira fosfolipaza C-protein kinaza C nizvodni signalni put, a 

H2 receptor aktivira signalni put fosfokinaze A. H3 receptor smješten je presinaptički i 

postsinaptički te je pretežno proučavan kao autoreceptor. Blokiranje H3 receptora pojačava 
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oslobađanje histamina koji zauzvrat modulira neuronsku funkciju i plastičnost te je kao takvo 

predloženo za liječenje mentalnih poremećaja (7). Neuronska ekspresija H4 receptora također 

je dokumentirana, ali je slabije istražena. Sva četiri receptora pripadaju obitelji receptora 

vezanih s G proteinima (engl. G protein-coupled receptors, GPCR) (2).  

1.1.1. H1 receptori 

Ljudski H1 receptor je protein građen od 487 aminokiselina, kodiran genom na 

kromosomu 3 (3p25). Ulazi u interakciju s Gq/11 proteinima kako bi aktivirao fosfolipazu C 

(engl. phospholipase C, PLC), promovirajući tako inozitol 1,4,5-trisfosfat (engl. inositol 1,4,5-

trisphosphate, IP3) ovisno otpuštanje Ca²⁺ iona iz unutarstaničnih prostora i diacilglicerol-

posredovanu aktivaciju protein kinaze C (engl. protein kinase C, PKC). Otpuštanje Ca²⁺ iz 

unutarstaničnih prostora dovodi do otvaranja kalcijevih kanala na staničnoj membrani te 

aktivacije natrij/kalcij izmjenjivača (2, 8). Drugi putevi signalizacije koji pokreću H1 receptor 

uključuju proizvodnju arahidonske kiseline, dušičnog oksida i cikličkog gvanozin-monofosfata 

(engl. cyclic guanosine monophosphate, cGMP) kroz stimulaciju fosfolipaze A2 (PLA2), NO 

sintaze ovisne o Ca²⁺ i gvanilil ciklaze ovisne o NO. Navedena stimulacija posredovana je Gi/o 

proteinom osjetljivim na toksin pertusis (2, 9). H1 receptori aktiviraju adenozin monofosfat-

kinazu (engl. adenosine monophosphate-activated protein kinase, AMPK), kontrolnu točku 

metabolizma energije, te nuklearni čimbenik kappa B, ključni transkripcijski čimbenik uključen 

u nadzor proliferacije i preživljenja (9). 

1.2. Antihistaminici 

Antihistaminici su lijekovi koji se koriste za liječenje alergijskih poremećaja. Imunološki 

sustav ima razne načine kako se nositi sa stranim organizmima koji ga napadaju. Ako strani 

organizam uspije pobijediti vanjsku liniju obrane i ući u organizam, nastupa jedan od dva načina 

obrane – urođeni (nespecifičan) ili stečeni (specifičan) imunološki odgovor. Kod ponovnog 

izlaganja stranom organizmu, dolazi do lučenja IgE protutijela te posljedične degranulacije 

mastocita koji otpuštaju histamin, heparin i neutralnu proteazu u izvanstanični okoliš. 

Specifična uloga histamina je da okoliš učini neprijateljski nastrojenim prema uljezu tako što 

povećava lučenje sluzi, izaziva svrbež, kihanje, kašljanje ili proljev, odnosno pospješuje 

mehaničko uklanjanje ovisno o napadnutom organu (10). 

Prva generacija antihistaminika otkrivena je prije otprilike 60 godina i dostupna je 40-ak 

godina. Ova sredstva su visoko potentni kompetitivni inhibitori histamina koji djeluju na H1 
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receptorsko mjesto na ciljnim stanicama u sluznici respiratornog sustava. Međutim, vrlo su 

lipofilni i lako prolaze krvno-moždanu barijeru (engl. blood-brain barrier, BBB) gdje blokiraju 

H1 receptorska mjesta u mozgu te izazivaju nuspojave (uključujući umor, pospanost, promjene 

raspoloženja, nemotiviranost) (11). Zbog navedenih nuspojava, nužno je da lijekovi sadrže 

upozorenja da korisnici ne upravljaju automobilom ili nekim opasnim strojem dok ih koriste. 

Istraživanja su pokazala slabiju koncentraciju u školi kod djece liječene antihistaminicima prve 

generacije u odnosu na djecu liječenu antihistaminicima druge generacije. Također, pokazalo 

se kako su ovi sedativni antihistaminici uzrok i avionskih nesreća (11, 12). 

Druga generacija antihistaminika razvijena je kako bi se smanjila ili potpuno eliminirala 

sedacija i štetni antikolinergički učinci koji se javljaju kod starijih antagonista H1 receptora. 

Lijekovi iz ove generacije relativno su lipofobni i imaju mali volumen distribucije te slabije 

prolaze kroz BBB (13). Stoga se smatraju najvećim farmakološkim napretkom u usporedbi sa 

svojim predcima te su se pokazali važnim terapijskim alatom u liječenju atopijske bolesti. 

Dostupno je mnogo antihistaminika druge generacije, no na prvi pogled se čini kako ih je malo 

za birati u smislu sigurnosti i djelotvornosti. Međutim, s vremenom je postalo očito da noviji 

antihistaminici zapravo predstavljaju heterogenu skupinu spojeva, različitih kemijskih 

struktura, s varijacijama u terapijskim profilima, štetnim učincima, poluživotu, raspodjeli u 

tkivima, metabolizmu i različitim stupnjevima antialergijskih učinaka (14). 

Farmakokinetika lijekova druge generacije ima sličan osnovni dio, no radikali ili bočni 

lanci su ti koji određuju apsorpciju, distribuciju, metabolizam i eliminaciju. Apsorpcija nakon 

oralne primjene varira od prilično dobre do izvrsne. Najviša koncentracija u plazmi općenito se 

postigne za 1 do 4 sata; cetirizin je najbrži i djeluje kroz pola sata, dok je azelastin najsporiji i 

doseže terapijsku dozu nakon 5 sati (13). Bitno je uzeti pravu dozu lijeka zbog varijacija u 

metabolizmu i raspodjeli u tkivima. Aktivnost i/ili toksičnost ovisna je o dva procesa: a) 

metabolizmu roditeljske tvari i aktivnim metabolitima u jetri, b) uklanjanju aktivnog lijeka i/ili 

metabolita putem žuči ili bubrega. Većina antihistaminika druge generacije podvrgava se 

opsežnom metabolizmu prvog prolaska do farmakološki aktivnih metabolita. Zajedničko im je 

obilježje da je reakcija potpomognuta citokromom P450 (engl. cytochrome P450, CYP) koji 

pripada CYP3A4 obitelji (13, 14). Neki metaboliti su 2 do 4 puta potentniji nego roditeljska 

tvar ili imaju sličnu potentnost s roditeljskom tvari. Ako je funkcija jetre oštećena, ili bolešću 

ili inhibicijom CYP sustava, roditeljska se tvar može nakupljati i može doći do toksičnosti. Svi 

antihistaminici druge generacije pokazuju klinički značajan bubrežni klirens i time dobru 

eliminaciju bubrezima (13). 
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Razlike u ukupnom poretku s obzirom na djelotvornost i sigurnost između raspoloživih 

antihistaminika druge generacije, ako se primjenjuju u ekvivalentnim dozama, nisu velike. 

Međutim, među trenutno dostupnim antihistaminicima, feksofenadin može ponuditi najbolju 

opću ravnotežu učinkovitosti i sigurnosti, i ovaj lijek je prikladan izbor za početnu terapiju ili 

prilikom izmjene terapija za većinu pacijenata s blagim ili umjerenim alergijskim simptomima. 

Cetirizin je prikladan za pacijente koji ne reagiraju na druge antihistaminike i za one s najtežim 

simptomima koji bi mogli imati korist od liječenja s najvišom potencijom koja može titrirati 

dozu do maksimalnog intenziteta (15). 

Antihistaminici su jedni od najčešćih lijekova koji se intenzivno koriste u raznim 

dermatološkim i nedermatološkim stanjima. Korištenje H1 antihistaminika tijekom trudnoće 

bilo je vrlo kontroverzno zbog mogućih teratogenih učinaka ovih lijekova (16). Prosječno 10-

15 % žena uzimaju antihistaminike tijekom trudnoće za olakšavanje mučnina i povraćanja, 

alergija i simptoma astme ili zbog loše probave, posebice u prvom tromjesečju (17). Nijedan 

od trenutno dostupnih antihistaminika nije kategoriziran kao siguran tijekom trudnoće. 

Kontrolne studije dostupne su za određene lijekove prve generacije, u smislu njihove sigurnosti 

u trudnoći, ali novije tvari zahtijevaju daljnja ispitivanja da se proglase sigurnima u trudnoći. 

Svaki lijek upotrijebljen u trudnoći nosi rizik od teratogenosti i prije toga treba pažljivo 

procijeniti rizik / korist propisujući ih (16).  

H1 antihistaminici koriste se za liječenje mučnina i povraćanja tijekom trudnoće koje se 

javljaju u otprilike 85 % trudnoća, kao i za simptomatsko olakšanje astme, urtikarije, alergija, 

prehlada i drugih stanja. H2 antihistaminici koriste se za liječenje probavnih smetnji i refluksa 

kiseline. Izloženost H1 antihistaminicima češća je tijekom prvog tromjesečja, dok je izlaganje 

H2 antihistaminicima češće nakon tog perioda (18). Prva generacija antagonista H1 receptora 

može proći BBB uzrokujući sedativne i antikolinergične nuspojave, dok druga generacija pak 

nema takve nuspojave (17). Bilo koji lijek korišten tijekom trudnoće ima potencijalan teratogeni 

učinak na fetus. Ako je lijek korišten u prvom tromjesečju, može uzrokovati strukturalne fetalne 

malformacije i u kasnijem dijelu trudnoće mogu uslijediti razni funkcionalni defekti ili 

poremećaji u rastu i slično. Stoga se u trudnoći nastoje izbjeći konzumacije bilo kakvih lijekova 

te liječnici važu prednosti u odnosu na potencijalne teratogene učinke prije korištenja bilo kojeg 

lijeka u trudnoći (16). 



Uvod 

5 

 

1.2.1. Bilastin 

 Bilastin je novi antagonist histaminskih receptora razvijen za liječenje simptoma 

alergijskog rinitisa i kronične idiopatske urtikarije (19, 20). Na temelju sposobnosti prelaska 

BBB pripada drugoj generaciji H1 antihistaminika koja uobičajeno ne može proći BBB, stoga 

ima slabije sedativne učinke. Dug period djelovanja, djelotvornost samog lijeka, niska sedacija 

i niska razina ometanja izvršavanja zadataka kod antihistaminika druge generacije, a posebice 

bilastina, čine ga potencijalno privlačnom terapijskom opcijom za alergologe (21). 

Farmakološka ispitivanja dokazala su da je bilastin vrlo selektivan za H1 receptore, a posjeduje 

i antihistaminička i protuupalna svojstva in vitro i in vivo. Nadalje, studije u zdravih 

dobrovoljaca pokazale su kako bilastin ima brz početak djelovanja (30-60 minuta) i dugo 

djelovanje (24 sata), nije podvrgnut niti jednom metabolizmu jetre te se uglavnom izlučuje 

stolicom (19). Ima srednje vrijeme polueliminacije od otprilike 12 do 14,5 sati. Prilagodba doze 

kod odraslih pacijenata s bubrežnom ili jetrenom disfunkcijom nije potrebna. Bilastin ne stupa 

u značajnu interakciju sa sustavom enzima CYP, stoga ovaj nedostatak, kao i nedostatak 

metabolizma u jetri, ograničavaju potencijalne interakcije između različitih lijekova (22). S 

molekularne točke gledišta, bilastin je 2-[4-(2-(4-(1-(2-etoksietil)-1Hbenzimidazol-2-il) 

piperidin-1-il) etil) fenil] -2-metil propionska kiselina. Pripada derivatima piperidina i nije 

strukturno izveden iz bilo kojeg drugog trenutno dostupnog antihistaminika (21). Za odrasle, 

bilastin se daje u pojedinačnoj dozi od 20 mg na dan te tako ne pokazuje nikakve znakove 

kardiotoksičnosti niti sedativne nuspojave. Također, poboljšava kvalitetu života pacijenata i ne 

umanjuje psihomotorne sposobnosti, a nedavno je odobren i za djecu u dobi od 6-11 godina 

(23, 24). 

Slika 1. Prikaz strukture molekule bilastina (izradila autorica). 
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1.2.2. Desloratadin 

 Desloratadin je aktivni metabolit loratadina. Njegov antihistaminski učinak traje 24 sata 

(25, 26). Za široku primjenu u klinici desloratadin pokazuje prednosti u odnosu na druge H1 

antihistaminike u tome što ima visoku H1 antihistaminsku aktivnost, širok terapijski raspon i 

mali potencijal za interakciju s drugim lijekovima. S druge strane, zabilježeno je da niska 

koncentracija desloratadina pokazuje sličan afinitet za histaminske H1 receptore i muskarinske 

receptore, što neizbježno može uzrokovati suhoću usta, vrtoglavicu, umor i slično, a može i 

izazvati sedativni učinak na pacijente sa kompromitiranom BBB (26). U ljudi, glavni in vivo 

metabolit desloratadina je 3-hidroksidesloratadin, koji se potom pretvara u 3-

hidroksidesloratadin O-glukuronid. 3-hidroksidesloratadin i njegov glukuronid se u približno 

jednakim količinama izlučuju kroz urin i stolicu, dok su 5- i 6-hidroksidesloratadin maloznačni 

metaboliti u mokraći i stolici (27, 28). Stvaranje 3-hidroksidesloratadina uključuje tri uzastopne 

reakcije: 1) N-glukuronidaciju desloratadina pomoću UDP-glukuronosiltransferaze 2B10; 2) 3-

hidroksilaciju desloratadina N-glukuronida pomoću CYP2C8 i 3) dekonjugaciju 3-

hidroksidesloratadina N-glukuronida (brza neenzimatska hidroliza glukuronida) (28). Prema 

svojoj molekularnoj strukturi, desloratadin je 8-klor-6,11-dihidro-11- (4-piperidiniliden) -5H ‐

Benzo [5,6] ciklohepta [1,2 ‐ b] piridin nastao od loratadina pomoću CYP3A4 i CYP2D6. 

Odobren je za liječenje alergijskog rinitisa i kronične idiopatske urtikarije diljem svijeta. 

Otkriveno je kako svakodnevna primjena 5 mg desloratadina značajno poboljšava problem 

začepljenog nosa i ukočenosti kod pacijenata s intermitentnim alergijskim rinitisom u usporedbi 

s placebom. Također, studije su pokazale kako brzo smanjuje simptome višegodišnjeg 

alergijskog rinitisa s minimalnim štetnim učincima (29). No, postoje izvješća o depresiji ili 

depresivnom raspoloženju za koje se sumnja da su uzrokovani desloratadinom. Oznaka na 

američkim proizvodima opisuje da je u kliničkim ispitivanjima 3,1 % djece između 12 i 23 

mjeseca starosti pokazalo osjećajnu nestabilnost nakon primanja desloratadina. Nuspojave 

sugeriraju da desloratadin može prijeći BBB, suprotno što se govori (30). 
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Slika 2. Prikaz strukture molekule desloratadina (izradila autorica). 

1.2.3. Antihistaminici u trudnoći i urođene mane 

 Antihistaminici se mogu koristiti za ublažavanje alergijskog rinitisa, infekcija gornjih 

dišnih putova, kao i za liječenje simptoma trudnoće kao što su mučnina, povraćanje, 

vrtoglavica, nesanica i drugi. Upotreba antihistaminika tijekom trudnoće kreće se od 4 do 10 % 

tijekom prvog tromjesečja i od 8 do 15 % u bilo kojem trenutku tijekom trudnoće. Nekoliko je 

studija ukazalo na povezanost između majčine uporabe nekih antihistaminika tijekom ranih 

mjeseci trudnoće i nekih urođenih mana. Tako su zabilježeni slučajevi hipospadije kod 

korištenja loratadina u ranoj trudnoći (31). S druge strane, Centar za kontrolu i prevenciju 

bolesti (engl. Center for Disease Control and Prevention, CDC) napravio je veliku studiju 

prevencije urođenih oštećenja te je prva objavljena studija istražila povezanost između 

hipospadije i izloženosti loratadinu. Pokazano je kako nema povezanosti između loratadina i 

hipospadije kod muške dojenčadi (32). Također, Suradnički perinatalni projekt pokazao je kako 

nema povećanog rizika za velike urođene malformacije nakon majčine uporabe bilo kojeg 

antihistaminika (doksilamin, klorfeniramin ili feniramin), no među svim skupinama izloženosti 

i skupinama malformacija jedan je dosegao statističku značajnost: klorfeniramin i malformacije 

oka i uha (33). Dva su glavna ograničenja koja otežavaju mnoga istraživanja: mala veličina 

uzorka (tj. neadekvatna snaga, posebno za bitne analize podgrupa) i rizik od pristranosti zbog 

pogrešne klasifikacije izloženosti zbog oslanjanja na podatke u receptu lijeka. Stoga su potrebne 

velike i dugogodišnje studije koje će proučavati povezanost urođenih mana s korištenjem 

lijekova (34). 
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1.3. Glijalni fibrilarni kiseli protein  

Glijalni fibrilarni kiseli protein (engl. glial fibrillary acidic protein, GFAP) citoskeletalni 

je protein iz skupine intermedijarnih filamenata. Nitaste je strukture i specifičan za stanični 

kostur zrelih astrocita, najzastupljenije vrste glija stanica CNS-a (35). Astrociti imaju niz 

kontrolnih i homeostatskih funkcija u zdravlju i bolesti te predstavljaju reaktivni fenotip kod 

akutnih trauma CNS-a, ishemije i neurodegenerativnih bolesti. GFAP igra bitnu ulogu u 

migraciji i pokretljivosti stanica, u sidrenju glutamatskog transportera GLAST/EAAT1 u 

membrani i u mitozi (36). Služi i za održavanje mehaničke čvrstoće, pružanje potpore 

susjednim neuronima i održavanje BBB (37). Također, on je astroglijalni biomarker ozljede. 

Izvrsno detektira i intrakranijalne lezije u pacijenata s blagom traumatskom ozljedom mozga 

koji imaju značajne ekstrakranijalne ozljede i prijelome te otkriva ozljedu aksona na magnetskoj 

rezonanci i 3 mjeseca nakon traumatske ozljede mozga (38). 

1.4. Neuronski jezgrin protein 

Neuronski jezgrin protein (engl. neuronal nuclear protein, NeuN) smješten je u jezgri 

zrelih neurona i perinuklearnoj citoplazmi većine neurona u CNS-u sisavaca. Nalazi se 

isključivo u živčanom tkivu te je specifični neuronski marker jer nikada nije detektiran u 

glijalnim stanicama (39). Široko je priznati biomarker koji se detektira u post-mitotskim 

neuronima te je rasprostranjen u gotovo svim dijelovima živčanog sustava kralježnjaka (40). 

Antitijela na NeuN aktivno se koriste u imunohistokemijskim istraživanjima neuronske 

diferencijacije kako bi se procijenila funkcionalnost neurona u normalnim i patološkim 

stanjima. Nivo ekspresije NeuN-a koristi se kako bi se direktno procijenio gubitak ili smrt 

neurona (39, 40). 

1.5. Neuroplastin 65 

Gen za neuroplastin kodira dvije izoforme sinaptičkog proteina, neuroplastin 55 (engl. 

neuroplastin 55, Np55) i neuroplastin 65 (engl. neuroplastin 65, Np65). Ovi su proteini 

transmembranski glikoproteini koji reguliraju nekoliko staničnih procesa, uključujući nastanak, 

održavanje i plastičnost sinapsi (41). Np65 je specifičan glikoprotein sinaptičke membrane 

mozga, koji je pretežno smješten u dijelovima mozga koji su povezani s pamćenjem i 

procesiranjem emocija kao što su frontalna kora, amigdala, striatum te hipokampus (42, 43). 

Gen za ovaj protein nalazi se na 15. kromosomu (15q24) te ima 12 egzona i 4 konzervirane 
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domene (tri imunoglobulinske domene i jednu unutarstaničnu C-terminalnu domenu). Np65 je 

u genetičkoj podlozi inteligencije kod ljudi, a funkcija mu je povezana sa staničnom adhezijom 

i neuronskom komunikacijom. Također, aktivira kinazu p38, a interakcija između Np65 i kinaze 

p38 podešava sinaptičku snagu, dok kinaza p38 pomaže matičnim stanicama da se diferenciraju 

u neurone (44). Pronađene su bitne razlike u ekspresiji neuroplastina između glodavaca i 

čovjeka. Kod ljudi, neuroplastin se nalazi i u malom mozgu u somi stanice, neuritima i 

neuropilu i to pretežno Np65 izoforma, dok u malom mozgu glodavaca prevladava Np55 (45). 
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2. HIPOTEZA 

Hipoteza ovog istraživanja je da antihistaminici desloratadin i bilastin djeluju na razvoj neurona 

i glije u mozgu embrija Sprague Dawley štakora, kao i na sinaptogenezu te izražaj H1 receptora. 

 

 



Ciljevi 

11 

 

3. CILJEVI 

Cilj studije je usporediti tri skupine mladunaca porijeklom od netretiranih majki ili majki 

tretiranih antihistaminicima s obzirom na izražaj H1 receptora, markere neurona i glije te 

neuroplastin kao marker sinaptogeneze. 
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4. MATERIJALI I METODE 

4.1. Ustroj studije 

 Studija je ustrojena kao istraživanje parova – životinje tretirane antihistaminicima u 

odnosu na životinje netretirane istim. 

4.2. Materijali 

 Studija je načinjena na arhivi tkiva prikupljenog RECOOP projektom voditeljice 

Vedrane Ivić koju je odobrilo Etičko povjerenstvo Sveučilišta u Szegedu, br. IV/3796/2015 te 

Etičko povjerenstvo za istraživanje Medicinskog fakulteta Osijek (Klasa: 602-04/20-08/07; 

Broj: 2158-61-07-20-45; dana 15. svibnja 2020.). U studiju je uključeno 36 životinja starosti 3 

mjeseca. Životinje su podijeljene u 3 skupine: 1. potomci netretiranih Sprague Dawley štakorica 

(kontrola), 2. potomci štakorica tretiranih desloratadinom, 3. potomci štakorica tretiranih 

bilastinom. U svakoj skupini nalazi se po 6 mužjaka i 6 ženki starosti 3 mjeseca. Prikupljena 

moždana tkiva fiksirana su otopinom 4 %-tnog paraformaldehida (Sigma-Aldrich, St. Louis, 

MO, SAD) na 24 sata, te krioprotektirana u otopinama saharoze udjela od 10 do 30 % (u 

fosfatnom puferu - engl. phosphate buffered saline, PBS) također u trajanju od 24 sata za svaku 

primijenjenu otopinu. Naposljetku, tkiva su pohranjena u zamrzivač na - 80 °C do daljnjeg 

postupanja.  

4.3. Metode 

 Uzorci tkiva mozga iz arhive izrezani su u koronarnom smjeru na kriostatu (Leica 

CM3050 S, Wetzlar, Njemačka) na debljinu 35 µm te su preparati do daljnje obrade pohranjeni 

u otopini po de Olmoshu (otopini za krioprotekciju) na 4 °C (46). Dio rezova ispran je PBS-om 

i navučen na predmetna stakla presvučena želatinom te su preparati osušeni preko noći na 

sobnoj temperaturi. Potom su obojeni histološkom bojom krezil violet (bojanje po Nisslu; 

Sigma-Aldrich, St. Louis, MO, SAD, kat. br.: 860980-5G) kojom se dobiva prikaz svih jezgara 

u mozgu te tako razaznaju slojevi mozga. Imunohistokemijom na slobodno plutajućim 

rezovima, uz pomoć visokospecifičnih protutijela na H1 receptor, neuronski jezgrin protein 

(NeuN, marker neurona), glijalni fibrilarni kiseli protein (GFAP, marker glije) te neuroplastin 

65 (molekula stanične adhezije, marker sinaptogeneze), prikazani su navedeni epitopi u tkivu 

mozga. Obojana tkiva nanesena su na predmetna stakla te pokrivena medijem za pokrivanje 
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(BioMount DPX, Biognost, Hrvatska, kat. br.: BM-500) i pokrovnim stakalcem. Dio preparata 

potom je fotografiran pod lupom pomoću fotoaparata (lupa SZX12, Japan; Canon EOS 2000D, 

Tokio, Japan) na ukupnom povećanju od 11,2× te 100×, a dio je fotografiran kamerom Olympus 

DP-70 spojenom s mikroskopom (Zeiss Axioskop 2 MOT, Jena, Germany) pri povećanju 

objektiva 20×. Korištenjem računalnog programa ImageJ v.1.80 s njegovim FIJI dodatkom 

(engl. plugin) kvantificirana su obojenja navedenih epitopa.  

4.3.1. Bojenje po Nisslu 

Korišteni su rezovi koji su prethodno navučeni na predmetna stakla te ostavljeni na 

sobnoj temperaturi da se osuše preko noći. Inkubirani su u trajanju od deset minuta u radnoj 

otopini krezil violet boje (Kemika, Hrvatska) koju smo pripremili iz matične otopine (5 %-tna 

otopina krezil violet boje u 20 %-tnoj otopini etanola) u omjeru 1:4 (1 dio matične otopine, 4 

dijela 20 %-tnog etanola) uz dodatak ledene octene kiseline (40 ml na 120 ml radne otopine) 

(47). Po isteku vremena inkubacije, rezovi su dehidrirani uranjanjem pet puta u niz otopina 

etanola različitih udjela sljedećim redoslijedom: 96 %-tni etanol te dva puta 100 %-tni etanol. 

Uslijedilo je uranjanje dva puta po pet minuta u ksilen (Carlo Erba Reagents, Francuska, kat. 

br.: 492301) te potom pokrivanje medijem za pokrivanje i pokrovnicama.  

4.3.2. Imunohistokemijske metode 

 Rezovi su izvađeni iz otopine po de Olmoshu, isprani tri puta u 1× PBS-u (pH 7,4; 137 

mM NaCl (Gram Mol d.o.o., Zagreb, Hrvatska; kat. br. P148590), 2,7 mM KCl (VWR 

International,  Radnor, Pennsylvania, SAD; kat. br. 26764.260), 10 mM NaH2PO4 (Gram Mol 

d.o.o., Zagreb, Hrvatska; kat. br. P143710), 1,8 mM KH2PO4 (Sigma Aldrich, St. Louis, 

Missouri, SAD; kat. br. P3786-100G)) te stavljeni u predtretman 1 %-tnim vodikovim 

peroksidom (Kemika, Zagreb) dva puta po dvadeset minuta kako bi zasitili aktivna mjesta 

endogenih peroksidaza. Zatim su prebačeni u blokirajuću otopinu i inkubirani tijekom dva sata 

na 4 °C uz konstantno miješanje da se blokiraju sve nespecifične reakcije. Blokirajuća otopina 

bila je 1 % BSA (engl bovine serum albumin, Sigma-Aldrich, St. Louis, MO, SAD) i 5 %-tni 

kozji serum (Gibco, Invitrogen, Auckland, NZ) pripremljeni u 1× PBS-u. Potom su rezovi 

prebačeni u otopinu primarnog protutijela pripremljenog u otopini za blokiranje. Uslijedila je 

inkubacija preko noći na tresilici, na 4 °C. Rezovi su zatim isprani tri puta po deset minuta u 

1× PBS-u te prebačeni u otopinu sekundarnog protutijela razrijeđenog u blokirajućoj otopini. 

Inkubirani su tijekom četiri sata na 4 °C na tresilici. Potom su isprani tri puta po deset minuta 

u 1× PBS-u te stavljeni u otopinu tercijarnog kompleksa (1:250 avidin i 1:250 biotin-HRP u 1× 
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PBS-u, Vector Laboratories, Burlingame, CA, SAD) na 4 °C uz neprekidno miješanje, tijekom 

dva sata. Uslijedilo je ispiranje tri puta po deset minuta u 1× PBS-u te razvijanje u otopini 

diaminobenzidina (DAB, engl. 3,3´-diaminobenzidine; Vector Laboratories, Burlingame, CA, 

SAD) priređenoj prema uputama proizvođača. Preparati su zatim navučeni na predmetna stakla 

i ostavljeni da se osuše. Pokriveni su medijem za pokrivanje i pokrovnim stakalcem.  

Tablica 1. Popis korištenih protutijela.  

OZNAKA 

Primarno 

protutijelo 

(proizvođač i 

razrjeđenje) 

Sekundarno 

protutijelo 

(proizvođač i 

razrjeđenje) 

Vrijeme 

razvijanja u 

otopini 

diaminobenzidina 

H1R 

protu-H1R 

(Alomone labs, 

Izrael, kat. br.: 

AHR-001; 

1:300) 

biotinilirano protu-

zečje IgG protutijelo 

(Vector Laboratories, 

Burlingame, CA, 

SAD, kat. br.: BA 

1000; 

1:500) 

3 min 

NeuN 

protu-NeuN 

(Millipore, 

Temecula, CA, 

SAD, kat. br.: 

MAB377; 

1:1000) 

biotinilirano kozje 

protu-mišje IgG 

protutijelo (Santa 

Cruz Biotechnology, 

Texas, SAD, kat. br.: 

SC-2039; 

1:500) 

1 min 

GFAP 

protu-GFAP (Dako, 

Santa Clara, CA, 

SAD, kat. br.: 

Z0334; 

1:4000) 

biotinilirano protu-

zečje IgG protutijelo 

(Vector Laboratories, 

Burlingame, CA, 

SAD, kat. br.: BA 

1000; 

1:500) 

1 min 

Np65 

protu-Np65 (R&D 

Systems, 

Minneapolis, MN, 

SAD, kat. br.: 

AF5360; 

1:300) 

sekundarno 

biotinilirano magareće 

protu-kozje IgG 

protutijelo (Abcam, 

Cambridge, UK, kat. 

br.: ab6884; 

1:500) 

1 min 

 

GFAP − glijalni fibrilarni kiseli protein, H1R − histaminski receptor 1, NeuN − neuronski 

jezgrin protein, Np65 − neuroplastin 65. 
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4.4. Računalna analiza histoloških i imunohistokemijskih rezultata 

4.4.1. Analiza debljine slojeva moždane kore u slušnoj i motoričkoj regiji 

Analiza histoloških preparata obojenih po Nisslu napravljena je u programu ImageJ prema 

sljedećem protokolu: 

1. Otvoriti sliku korištenjem alatne trake izbornika File→ Open → odabrati željenu sliku. 

2. Kalibrirati sliku tako da se u alatnoj traci odabere naredba Straight line (ravna linija) i 

preko cijele dužine mjerne skale sa slike povuče ravna linija. U izborniku Analyze → 

Set scale potrebno je unijeti udaljenost u pikselima (Distance in pixels, udaljenost koju 

predstavlja skala = 304 piksela), poznatu udaljenost (Known distance, udaljenost u 

milimetrima koju predstavlja skala = 1 mm), omjer piksela (Pixel aspect ratio = 1) i 

mjernu jedinicu dužine (Unit of length = mm). Kako bi program primijenio kalibraciju 

na sve slike koje će se analizirati potrebno je odabrati naredbu Global (Slika 3a). 

3. Sliku prevesti u 8-bitni oblik pomoću alatne trake izbornika Image → Type → 8-bit. 

4. Zatim pojačati lokalni kontrast koristeći naredbu Process → CLAHE (Slika 3b). 

5. Izdvojiti moždano područje od interesa tako što se na alatnoj traci odabere Rectangle 

(pravokutnik), označiti Au1/M1 područje i duplicirati pomoću Image → Duplicate te 

potom imenovati novonastalu sliku. 

6. Na traci odabrati naredbu Analyze → Tools → ROI manager i pomoću Polygon 

(mnogokut) alata odrediti slojeve u odabranom području mozga. Označiti sloj 1 → add 

ROI, isto tako ponoviti sa slojevima 2/3, 4 i 5/6 (Slika 3c). Kliknuti naredbu Measure 

(izmjeri) i prenijeti dobivene podatke u Excel. 

Isti protokol primijenjen je na obje analizirane regije kore mozga: slušnu (Au1) i motoričku 

(M1) primarnu koru. 
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Slika 3. Analiza debljine slojeva moždane kore u slušnoj i motoričkoj regiji kore mozga, koraci 

1-6. a) Kalibracija slike, b) pojačavanje lokalnog kontrasta, c) analiza slojeva korištenjem ROI 

manager naredbe. 

4.4.2. Prebrojavanje stanica nakon imunohistokemijskog bojenja 

Imunohistokemijskim metodama odvojeno su prikazani neuroni i glija stanice. Kako smo kod 

bojenja neurona upotrijebili epitop za protein smješten u jezgri, a kod bojenja glija stanica 

citoplazmatski epitop specifičan za citoskelet − protokoli analize se međusobno razlikuju pa su 

zasebno objašnjeni. 

Analiza broja neurona 

Broj neurona određen je kvantifikacijom NeuN pozitivnih jezgara prema sljedećem protokolu: 

1. Otvoriti sliku korištenjem alatne trake izbornika File→ Open → odabrati željenu sliku. 

2. Kalibrirati sliku tako da se u alatnoj traci odabere naredba Straight line (ravna linija) i 

preko cijele dužine mjerne skale sa slike povuče ravna linija. U izborniku Analyze → 

Set scale potrebno je unijeti udaljenost u pikselima (Distance in pixels, udaljenost koju 

predstavlja skala = 2760 piksela), poznatu udaljenost (Known distance, udaljenost u 

inčima koju predstavlja skala = 7.89 inč), omjer piksela (Pixel aspect ratio = 1) i mjernu 

jedinicu dužine (Unit of length = inč). Kako bi program primijenio opisanu kalibraciju 

na sve slike koje će se analizirati potrebno je odabrati naredbu Global (Slika 4a). 

3. Slika koja se analizira je stack (kombinacija) triju kanala (crveni, zeleni i plavi), 

odnosno slika je troslojna. Potrebno ju je prevesti u samo jedan sloj naredbom Image → 

Type → RGB color nakon čega se otvori novi prozor s jednoslojnom slikom. 
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4. Zatim nacrtati pravokutnik ili kvadrat pomoću Rectangle (pravokutnik) alata pa 

specificirati površinu 5x5 inča koristeći naredbu Edit → Selection → Specify. U polja 

width i height upisati 5 te označiti kvačicom constrain square/circle i scaled units (Slika 

4b). 

5. Naredbom Image → Duplicate dobije se odabrana površina za mjerenje u novom 

prozoru. 

6. Sliku prevesti u 8-bitni oblik pomoću alatne trake izbornika Image → Type → 8-bit. 

7. Ukloniti pozadinske šumove preko izbornika Process → Noise → Despeckle. 

8. Prilagoditi prag naredbom Image → Adjust → Threshold tako da se prva klizeća traka 

postavi na 0, a druga na 148 te se odabere Apply. Tako se dobije negativ slike gdje su 

neuroni bijele boje, a ostatak slike crne boje (Slika 4c).  

9. Na traci odabrati naredbu Process → Binary → Watershed kako bi program 

višestaničnu česticu razdvojio na nekoliko čestica (stanica).  

10. Zatim postaviti parametre za kvantifikaciju koristeći Analyze → Set Measurements 

(Slika 4d) te analizirati stanice naredbom Analyze → Analyze Particles (Slika 4e). 

11. Dobivene podatke prenijeti u Excel. 
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Slika 4. Prebrojavanje neurona u slušnoj i motoričkoj regiji kore mozga, koraci 1-11. a) 

Kalibracija slike, b) specificiranje površine, c) prilagođavanje praga naredbom Threshold, d) 

postavljanje parametara za kvantifikaciju, e) analiza broja stanica. 
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Broj glija stanica 

Broj glija stanica određen je kvantifikacijom GFAP pozitivnih stanica prema sljedećem 

protokolu: 

1. Otvoriti sliku korištenjem alatne trake izbornika File→ Open → odabrati željenu sliku. 

2. Kalibrirati sliku tako da se u alatnoj traci odabere naredba Straight line (ravna linija) i 

preko cijele dužine mjerne skale sa slike povuče ravna linija. U izborniku Analyze → 

Set scale potrebno je unijeti udaljenost u pikselima (Distance in pixels, udaljenost koju 

predstavlja skala = 2760 piksela), poznatu udaljenost (Known distance, udaljenost u 

inčima koju predstavlja skala = 7.89 inč), omjer piksela (Pixel aspect ratio = 1) i mjernu 

jedinicu dužine (Unit of length = inč). Kako bi program primijenio opisanu kalibraciju 

na sve slike koje će se analizirati potrebno je odabrati naredbu Global. 

3. Sliku prevesti u 8-bitni oblik pomoću alatne trake izbornika Image → Type → 8-bit. 

4. Zatim ukloniti pozadinske šumove naredbom Process → Noise → Despeckle. 

5. Konvertirati sliku u binarni oblik tako da se na alatnoj traci odabere Process → Binary 

→ Make Binary. Tako se dobije slika crne pozadine gdje su glija stanice bijele boje 

(Slika 5a). 

6. Kliknuti naredbu Measure (izmjeri) i prenijeti dobivene podatke u Excel. 

7. Potom otvoriti 8-bitnu sliku i putem naredbe Plugins → Analyze → Cell Counter i 

odabira tipa brojača pokrenuti brojenje stanica klikom na initialize (počni). Označavati 

glija stanice sve dok se ne dođe do zadnje (Slika 5b). 

8. U Excel unijeti ukupan broj iz brojača stanica. 

 

Slika 5. Prebrojavanje stanica glije u slušnoj i motoričkoj regiji kore mozga, koraci 1-8. a) 

Konvertiranje slike u binarni oblik, b) prebrojavanje glija stanica pomoću brojača. 
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4.4.3. Analiza izražaja staničnih proteina 

Izražaj proteina H1R i Np65 kvantificiran je u određenoj površini kore mozga prema sljedećem 

protokolu: 

1. Otvoriti slike korištenjem alatne trake izbornika File→ Open → odabrati željene slike 

(prvo kontrolna skupina, zatim bilastin pa desloratadin). 

2. Napraviti stack (kombinacija) od slika odabirom naredbe na alatnoj traci Image → 

Stacks → Images to Stack 

3. Slike prevesti u 8-bitni oblik pomoću alatne trake izbornika Image → Type → 8-bit. 

4. Od stack-a slika napraviti montažu tako da se odabere Image → Stack → Make Montage 

(s lijeva na desno su poredane skupine kako su se otvarale slike : 1. kontrola, 2. bilastin 

i 3. desloratadin) (Slika 6a). 

5. Kalibrirati sliku tako da se u alatnoj traci odabere naredba Straight line (ravna linija) i 

preko cijele dužine mjerne skale sa slike povuče ravna linija. U izborniku Analyze → 

Set scale potrebno je unijeti udaljenost u pikselima (Distance in pixels, udaljenost koju 

predstavlja skala = 478 piksela), poznatu udaljenost (Known distance, udaljenost u 

inčima koju predstavlja skala = 100 μm), omjer piksela (Pixel aspect ratio = 1) i mjernu 

jedinicu dužine (Unit of length = μm). Kako bi program primijenio opisanu kalibraciju 

na sve slike koje će se analizirati potrebno je odabrati naredbu Global (Slika 6b). 

6. Zatim odrediti izlazne informacije mjerenja naredbom Analyze → Set Measurements 

(Slika 6c). 

7. Nacrtati ROI na jednoj slici koristeći se Rectangle (pravokutnik) alatom tako da se 

nacrta pravokutnik ili kvadrat, specificira mu se površina primjenom naredbe Edit → 

Selection → Specify. Površina koja se analizira iznosi 400×400 μm² (Slika 6d). 

8. Kliknuti naredbu Analyze → Measure i dobivene podatke prenijeti u Excel. Iz 

dobivenog mjerenja računati integralnu gustoću obojenja (engl. Integrated Density 

Value, IDV), odnosno koliko sivog pripada imunopozitivnoj reakciji, tako da se od 

najveće moguće vrijednosti svakog piksela u analiziranoj površini (Max IDV = 

255*Area) oduzme IntDen (Integrated Density) vrijednost (Slika 6e).  
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Slika 6. Analiza izražaja staničnih proteina, koraci 1-8. a) Montaža slika, b) kalibracija slike, c) 

postavljanje mjerenja, d) specifikacija površine pravokutnika, e) računanje vrijednosti 

integralne gustoće obojenja (IDV). 

4.5. Statističke metode 

 Kategorijski podaci predstavljeni su apsolutnim i relativnim frekvencijama. Normalnost 

raspodjele numeričkih varijabli testirana je Shaphiro-Wilkovim testom. Numerički podaci 

opisani su aritmetičkom sredinom i standardnom devijacijom u slučaju normalne raspodjele, a 

u ostalim slučajevima medijanom i granicama interkvartilnog raspona. Da bi utvrdili kako spol 

jedinke i intrauterini tretman utječu na kvantificirane slojeve moždane kore i epitope, u slučaju 

normalne raspodjele podaci su analizirani dvosmjernim ANOVA testom, a u slučaju odstupanja 
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od normalne raspodjele Mann-Whitneyevim U-testom. Za ocjenu značajnosti dobivenih 

rezultata odabrana je razina značajnosti α = 0,05. Statistička analiza obrađena je u programu 

Past 4.03 (Oyvind Hammer, Oslo, Norveška). 
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5. REZULTATI 

5.1. Analiza anatomije mozga 

Na temelju histološkog bojenja po Nisslu izradili smo prikaze anatomije mozga mužjaka 

i ženki Sprague Dawley štakora (Slika 7). Iz navedenih prikaza vidljivo je da je došlo do 

promjena u hipokampusu kod skupina koje su intrauterino tretirane antihistaminicima 

bilastinom i desloratadinom. Naime, područje hipokampusa kontrolnih skupina ima zaglađen 

oblik, dok se kod tretiranih skupina primjećuje „nabranost“ hipokampusa (Slika 7). 
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Slika 7. Prikazi anatomije kora mozga mužjaka i ženki Sprague Dawley štakora. Povećanje 7×. BM − mužjaci intrauterino tretirani 

antihistaminikom bilastinom, BŽ − ženke intrauterino tretirane antihistaminikom bilastinom, DM − mužjaci intrauterino tretirani antihistaminikom 

desloratadinom, DŽ − ženke intrauterino tretirane antihistaminikom desloratadinom, KM − kontrolna skupina mužjaka, KŽ − kontrolna skupina 

ženki.
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5.2. Analiza debljine slojeva moždane kore u slušnoj i motoričkoj kori mozga 

 Na temelju histološkog bojenja po Nisslu i imunohistokemijskog bojenja neuronskog 

jezgrinog proteina (NeuN) određeni su sljedeći slojevi moždane kore u primarnom slušnom 

(Au1) i primarnom motoričkom (M1) području kore mozga: sloj 1, slojevi 2 i 3, sloj 4 te slojevi 

5 i 6. Izmjerena je njihova debljina i izračunat udio u analiziranom području moždane kore kako 

bi se utvrdilo na koji način spol jedinke i intrauterini tretman antihistaminicima djeluju na udio 

slojeva moždane kore u navedenim područjima.  

Analiza debljine slojeva u primarnoj slušnoj kori mozga 

 Analiza debljine slojeva moždane kore u primarnoj slušnoj kori mozga Sprague Dawley 

štakora pokazala je kako nema statistički značajnih učinaka na udio sloja 1 u Au1 području 

kore. Nadalje, pokazalo se kako je učinak spola na udio slojeva 2 i 3 u Au1 području moždane 

kore statistički značajan F(1,17) = 14,45, p = 0,003. Skupine ženki imale su veći udio slojeva 2 i 

3 u odnosu na skupine mužjaka (Slika 8). Učinci tretmana te interakcije spola i tretmana nisu 

bili statistički značajni u ovim slojevima. Također, nema statistički značajnih učinaka na udio 

sloja 4 u Au1 području moždane kore. Daljnjom analizom pokazalo se kako je učinak spola na 

udio slojeva 5 i 6 u Au1 području moždane kore statistički značajan F(1,17) = 8,653, p = 0,012. 

Skupine mužjaka imale su veći udio slojeva 5 i 6 u odnosu na skupine ženki (Slika 8). Učinci 

tretmana te interakcije spola i tretmana nisu bili statistički značajni. 

 

Slika 8. Analiza debljine slojeva moždane kore u primarnoj slušnoj kori mozga (Au1) mužjaka 

i ženki Sprague Dawley štakora na temelju imunohistokemijskog bojenja neuronskog jezgrinog 
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proteina. Prikazane su srednje vrijednosti sa standardnim devijacijama. Podaci su statistički 

analizirani dvosmjernim ANOVA testom uz Tukeyjev post hoc. BM − mužjaci intrauterino 

tretirani antihistaminikom bilastinom, BŽ − ženke intrauterino tretirane antihistaminikom 

bilastinom, DM − mužjaci intrauterino tretirani antihistaminikom desloratadinom, DŽ − ženke 

intrauterino tretirane antihistaminikom desloratadinom, KM − kontrolna skupina mužjaka, KŽ 

− kontrolna skupina ženki. 

Analiza debljine slojeva u primarnoj motoričkoj kori mozga 

 Analizom slojeva moždane kore u primarnoj motoričkoj (M1) kori mozga Sprague 

Dawley štakora dvosmjerni ANOVA test otkrio je kako na udio slojeva 1, 2 i 3 nema statistički 

značajnih učinaka. Daljnjom analizom pokazalo se kako je interakcija intrauterinog tretmana i 

spola jedinke statistički značajno utjecala na udio sloja 4 u M1 području moždane kore F(2,17) = 

11,38, p = 0,002. Post hoc test otkriva da su mužjaci iz skupine B imali statistički značajno 

manji udio sloja 4 u M1 području moždane kore u odnosu na kontrolnu skupinu (p = 0,021). 

Također, ista skupina mužjaka imala je statistički značajno manji udio sloja 4 u odnosu na 

skupinu B ženki (p = 0,035) (Slika 9). Učinci tretmana i spola nisu bili značajni u ovom sloju. 

Učinak tretmana na udio slojeva 5 i 6 u M1 području moždane kore pokazao je statističku 

značajnost F(2,17) = 4,022, p = 0,046. Post hoc test otkriva da je skupina B imala statistički 

značajno manji udio slojeva 5 i 6 u M1 području moždane kore u odnosu na kontrolnu skupinu 

(p = 0,043) (Slika 9). Učinci spola te interakcije spola i tretmana nisu bili statistički značajni.  

 

Slika 9. Analiza debljine slojeva moždane kore u primarnoj motoričkoj kori mozga (M1) 

mužjaka i ženki Sprague Dawley štakora na temelju imunohistokemijskog bojenja neuronskog 
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jezgrinog proteina. Prikazane su srednje vrijednosti sa standardnim devijacijama. Podaci su 

statistički analizirani dvosmjernim ANOVA testom uz Tukeyjev post hoc. BM − mužjaci 

intrauterino tretirani antihistaminikom bilastinom, BŽ − ženke intrauterino tretirane 

antihistaminikom bilastinom, DM − mužjaci intrauterino tretirani antihistaminikom 

desloratadinom, DŽ − ženke intrauterino tretirane antihistaminikom desloratadinom, KM − 

kontrolna skupina mužjaka, KŽ − kontrolna skupina ženki. 

5.3. Usporedba omjera neurona i astroglije u slušnoj i motoričkoj kori mozga 

eksperimentalnih skupina u odnosu na kontrolnu skupinu 

 Tijela neurona vizualizirana su imunohistokemijskim bojenjem NeuN-a, a astroglija 

imunohistokemijskim bojenjem GFAP-a. Sve imunopozitivne stanice u Au1 i M1 područjima 

moždane kore prebrojane su te je izračunat omjer neurona i astroglije kako bi se utvrdilo na 

koji način spol jedinke i intrauterini tretman antihistaminicima djeluju na omjer neurona i glije 

u navedenim područjima. 

Usporedba omjera neurona i glije u Au1 području 

  Na temelju kvantifikacije imunopozitivnih stanica na NeuN i GFAP (Slika 10) 

provedena je analiza dvosmjernim ANOVA testom. Analiza je pokazala kako samo tretman 

antihistaminicima izaziva statistički značajne učinke F(2,17) = 10,16, p = 0,003, dok spol te 

interakcija spola i tretmana nisu bili statistički značajni (Slika 11). Detaljnijom analizom 

pomoću Tukeyjevog post hoc testa otkrili smo da, kada se usporedi s kontrolnom skupinom, i 

bilastin (p = 0,003) i desloratadin (p = 0,013) izazivaju povećanje omjera neurona i glije u Au1 

području moždane kore. 
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Slika 10. Imunohistokemijski prikazi slušne kore mozga mužjaka i ženki Sprague Dawley 

štakora testiranih protutijelima na neuronski jezgrin protein (NeuN) i glijalni fibrilarni kiseli 

protein (GFAP). Povećanje 200×. S lijeva na desno: Neg − negativna kontrola, K − kontrolna 

skupina, B − skupina tretirana antihistaminikom bilastinom, D − skupina tretirana 

antihistaminikom desloratadinom. 
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Slika 11. Omjer NeuN- i GFAP-imunopozitivnih stanica u slušnoj (Au1) moždanoj kori 

mužjaka i ženki Sprague Dawley štakora. Podaci su statistički analizirani dvosmjernim 

ANOVA testom uz Tukeyjev post hoc. BM − mužjaci intrauterino tretirani antihistaminikom 

bilastinom, BŽ − ženke intrauterino tretirane antihistaminikom bilastinom, DM − mužjaci 

intrauterino tretirani antihistaminikom desloratadinom, DŽ − ženke intrauterino tretirane 

antihistaminikom desloratadinom, KM − kontrolna skupina mužjaka, KŽ − kontrolna skupina 

ženki.  

Usporedba omjera neurona i glije u motoričkoj kori mozga 

 Na temelju kvantifikacije imunopozitivnih stanica na NeuN i GFAP (Slika 12) 

provedena je analiza dvosmjernim ANOVA testom. Usporedbom omjera NeuN i GFAP u M1 

području moždane kore Sprague Dawley štakora eksperimentalnih skupina s kontrolnom 

skupinom, test je pokazao kako učinci spola, tretmana te interakcije spola i tretmana nisu bili 

statistički značajni (Slika 13). 
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Slika 12. Imunohistokemijski prikazi motoričke kore mozga mužjaka i ženki Sprague Dawley 

štakora testiranih protutijelima na neuronski jezgrin protein (NeuN) i glijalni fibrilarni kiseli 

protein (GFAP). Povećanje 200×. S lijeva na desno: Neg − negativna kontrola, K − kontrolna 

skupina, B − skupina tretirana antihistaminikom bilastinom, D − skupina tretirana 

antihistaminikom desloratadinom. 
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Slika 13. Omjer NeuN- i GFAP-imunopozitivnih stanica u motoričkoj moždanoj kori mužjaka 

i ženki Sprague Dawley štakora. Podaci su statistički analizirani dvosmjernim ANOVA testom 

uz Tukeyjev post hoc. BM − mužjaci intrauterino tretirani antihistaminikom bilastinom, BŽ − 

ženke intrauterino tretirane antihistaminikom bilastinom, DM − mužjaci intrauterino tretirani 

antihistaminikom desloratadinom, DŽ − ženke intrauterino tretirane antihistaminikom 

desloratadinom, KM − kontrolna skupina mužjaka, KŽ − kontrolna skupina ženki. 

5.4. Analiza izražaja histaminskog receptora 1 

Izražaj histaminskog receptora 1 u primarnoj slušnoj kori mozga 

 Na temelju kvantifikacije imunopozitivnih stanica na H1R (Slika 14) provedena je 

analiza izražaja navedenog receptora u Au1 području moždane kore Sprague Dawley štakora 

dvosmjernim ANOVA testom. Analiza je pokazala kako učinci spola, tretmana te interakcije 

spola i tretmana nisu bili statistički značajni (Slika 15). 
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Slika 14. Imunohistokemijski prikazi slušne kore mužjaka i ženki Sprague Dawley štakora 

testiranih protutijelom na histaminski receptor 1. Povećanje 200×. S lijeva na desno: Neg − 

negativna kontrola, K − kontrolna skupina, B − skupina tretirana antihistaminikom bilastinom, 

D − skupina tretirana antihistaminikom desloratadinom. 

 

Slika 15. Izražaj histaminskog receptora 1 u slušnoj kori mužjaka i ženki Sprague Dawley 

štakora. Podaci su statistički analizirani dvosmjernim ANOVA testom uz Tukeyjev post hoc. 

BM − mužjaci intrauterino tretirani antihistaminikom bilastinom, BŽ − ženke intrauterino 

tretirane antihistaminikom bilastinom, DM − mužjaci intrauterino tretirani antihistaminikom 

desloratadinom, DŽ − ženke intrauterino tretirane antihistaminikom desloratadinom, IDV − 

vrijednost integrirane gustoće (engl. integrated density value), KM − kontrolna skupina 

mužjaka, KŽ − kontrolna skupina ženki. 
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Izražaj histaminskog receptora 1 u CA3 području hipokampusa 

 Na temelju kvantifikacije imunopozitivnih stanica na H1R (Slika 16) provedena je 

analiza izražaja navedenog receptora u CA3 području hipokampusa Sprague Dawley štakora 

dvosmjernim ANOVA testom. Analiza izražaja pokazala je da tretman sam po sebi uzrokuje 

statistički značajan učinak F(2,35) = 4,853, p = 0,015 (Slika 17). Također, učinak interakcije spola 

i tretmana bio je statistički značajan F(2,35) = 31,09, p = 4,861×10-8, dok sam spol ne dovodi do 

statistički značajnih učinaka. Tretman desloratadinom doveo je do povećanja izražaja H1R u 

CA3 području hipokampusa u odnosu na kontrolnu skupinu (p = 0,015).. Post hoc test otkrio je 

kako je skupina BM imala statistički značajno veći izražaj H1R u CA3 području u odnosu na 

KM (p = 6,78×10-6), dok je skupina BŽ imala statistički značajno manji izražaj H1R u odnosu 

na KŽ (p = 0,037). Također, skupina BM imala je statistički značajno veći izražaj H1R u odnosu 

na BŽ (p = 1,682×10-6) te je skupina DŽ imala veći izražaj u odnosu na DM (p = 5,129×10-5) 

(Slika 17). 

 

Slika 16. Imunohistokemijski prikazi CA3 područja hipokampusa mužjaka i ženki Sprague 

Dawley štakora testiranih protutijelom na histaminski receptor 1. Povećanje 200×. S lijeva na 

desno: Neg − negativna kontrola, K − kontrolna skupina, B − skupina tretirana 

antihistaminikom bilastinom, D − skupina tretirana antihistaminikom desloratadinom. 
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Slika 17. Izražaj histaminskog receptora 1 u CA3 području hipokampusa mužjaka i ženki 

Sprague Dawley štakora. Podaci su statistički analizirani dvosmjernim ANOVA testom uz 

Tukeyjev post hoc. BM − mužjaci intrauterino tretirani antihistaminikom bilastinom, BŽ − 

ženke intrauterino tretirane antihistaminikom bilastinom, DM − mužjaci intrauterino tretirani 

antihistaminikom desloratadinom, DŽ − ženke intrauterino tretirane antihistaminikom 

desloratadinom, IDV − vrijednost integrirane gustoće (engl. integrated density value), KM − 

kontrolna skupina mužjaka, KŽ − kontrolna skupina ženki. 

Izražaj histaminskog receptora 1 u području dentatnog girusa hipokampusa 

 Na temelju kvantifikacije imunopozitivnih stanica na H1R (Slika 18) provedena je 

analiza izražaja navedenog receptora u području dentatnog girusa (DG) hipokampusa Sprague 

Dawley štakora dvosmjernim ANOVA testom. Test je pokazao kako je učinak interakcije 

tretmana i spola statistički značajan u analiziranom području F(2,17) = 11,3, p = 0,002 (Slika 19). 

Učinci spola i tretmana nisu bili statistički značajni. Tukeyjev post hoc test otkriva da je skupina 

BM imala statistički značajno veći izražaj H1R u DG području u odnosu na KM (p = 0,028) te 

kako je skupina BŽ imala statistički značajno veći izražaj u odnosu na BM (p = 0,023).  
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Slika 18. Imunohistokemijski prikazi DG područja hipokampusa mužjaka i ženki Sprague 

Dawley štakora testiranih protutijelom na histaminski receptor 1. Povećanje 200×. S lijeva na 

desno: Neg − negativna kontrola, K − kontrolna skupina, B − skupina tretirana 

antihistaminikom bilastinom, D − skupina tretirana antihistaminikom desloratadinom. 

 

Slika 19. Izražaj histaminskog receptora 1 u DG području hipokampusa mužjaka i ženki 

Sprague Dawley štakora. Podaci su statistički analizirani dvosmjernim ANOVA testom uz 

Tukeyjev post hoc. BM − mužjaci intrauterino tretirani antihistaminikom bilastinom, BŽ − 

ženke intrauterino tretirane antihistaminikom bilastinom, DM − mužjaci intrauterino tretirani 

antihistaminikom desloratadinom, DŽ − ženke intrauterino tretirane antihistaminikom 

desloratadinom, IDV − vrijednost integrirane gustoće (engl. integrated density value), KM − 

kontrolna skupina mužjaka, KŽ − kontrolna skupina ženki. 
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Izražaj histaminskog receptora 1 u jezgri substantia nigra srednjeg mozga 

 Na temelju kvantifikacije imunopozitivnih stanica na H1R (Slika 20) provedena je 

analiza izražaja receptora u jezgri substantia nigra (SNR) srednjeg mozga Sprague Dawley 

štakora dvosmjernim ANOVA testom. Analiza izražaja pokazala je da samo tretman izaziva 

statistički značajan učinak F(2,17) = 5,913, p = 0,016 (Slika 21). Učinci spola te interakcije spola 

i tretmana nisu doveli do statistički značajnog rezultata. Tretman bilastinom izazvao je 

povećanje izražaja H1R kod mužjaka, a smanjenje izražaja H1R kod ženki u odnosu na 

kontrolnu skupinu (p = 0,016). 

 

Slika 20. Imunohistokemijski prikazi jezgre substantia nigra srednjeg mozga mužjaka i ženki 

Sprague Dawley štakora testiranih protutijelom na histaminski receptor 1. Povećanje 200×. S 

lijeva na desno: Neg − negativna kontrola, K − kontrolna skupina, B − skupina tretirana 

antihistaminikom bilastinom, D − skupina tretirana antihistaminikom desloratadinom. 
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Slika 21. Izražaj histaminskog receptora 1 u jezgri substantia nigra srednjeg mozga mužjaka i 

ženki Sprague Dawley štakora. Podaci su statistički analizirani dvosmjernim ANOVA testom 

uz Tukeyjev post hoc. BM − mužjaci intrauterino tretirani antihistaminikom bilastinom, BŽ − 

ženke intrauterino tretirane antihistaminikom bilastinom, DM − mužjaci intrauterino tretirani 

antihistaminikom desloratadinom, DŽ − ženke intrauterino tretirane antihistaminikom 

desloratadinom, IDV − vrijednost integrirane gustoće (engl. integrated density value), KM − 

kontrolna skupina mužjaka, KŽ − kontrolna skupina ženki. 

Izražaj histaminskog receptora 1 u tuberomamilarnoj jezgri hipotalamusa 

 Na temelju kvantifikacije imunopozitivnih stanica na H1R (Slika 22) provedena je 

analiza izražaja receptora u tuberomamilarnoj (TMN) jezgri hipotalamusa Sprague Dawley 

štakora dvosmjernim ANOVA testom. Analiza je pokazala statistički značajan rezultat u slučaju 

učinaka tretmana F(2,17) = 6,663, p = 0,011 te interakcije spola i intrauterinog tretmana F(2,17) = 

9,459, p = 0,003 (Slika 23). Učinak spola sam po sebi nije bio statistički značajan. Post hoc test 

učinaka tretmana otkriva da je tretman desloratadinom izazvao promjenu izražaja H1R u TMN 

području (p = 0,009). Također, post hoc analiza otkrila je da statistički značajno veći izražaj 

H1R ima skupina BM u odnosu na KM (p = 0,033) te kako ujedno i skupina DŽ ima statistički 

značajno veći izražaj u odnosu na KŽ (p = 0,024).  
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Slika 22. Imunohistokemijski prikazi tuberomamilarne jezgre hipotalamusa mužjaka i ženki 

Sprague Dawley štakora testiranih protutijelom na histaminski receptor 1. Povećanje 200×. S 

lijeva na desno: Neg − negativna kontrola, K − kontrolna skupina, B − skupina tretirana 

antihistaminikom bilastinom, D − skupina tretirana antihistaminikom desloratadinom. 

 

Slika 23. Izražaj histaminskog receptora 1 u tuberomamilarnoj jezgri hipotalamusa mužjaka i 

ženki Sprague Dawley štakora. Podaci su statistički analizirani dvosmjernim ANOVA testom 

uz Tukeyjev post hoc. BM − mužjaci intrauterino tretirani antihistaminikom bilastinom, BŽ − 

ženke intrauterino tretirane antihistaminikom bilastinom, DM − mužjaci intrauterino tretirani 

antihistaminikom desloratadinom, DŽ − ženke intrauterino tretirane antihistaminikom 

desloratadinom, IDV − vrijednost integrirane gustoće (engl. integrated density value), KM − 

kontrolna skupina mužjaka, KŽ − kontrolna skupina ženki. 
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5.5. Analiza izražaja neuroplastina 65 

Izražaj neuroplastina 65 u primarnoj slušnoj kori mozga 

 Na temelju kvantifikacije imunopozitivnih stanica na Np65 (Slika 24) provedena je 

analiza izražaja receptora u Au1 području moždane kore Sprague Dawley štakora dvosmjernim 

ANOVA testom. Analizom izražaja otkriveno je kako je statistički značajan samo učinak spola 

F(1,17) = 11,07, p = 0,006 (Slika 25). Ženke pokazuju veći izražaj Np65 u odnosu na mužjake. 

Učinci tretmana te interakcije spola i tretmana nisu bili statistički značajni. 

 

Slika 24. Imunohistokemijski prikazi slušne kore mužjaka i ženki Sprague Dawley štakora 

testiranih protutijelom na neuroplastin 65. Povećanje 200×. S lijeva na desno: Neg − negativna 

kontrola, K − kontrolna skupina, B − skupina tretirana antihistaminikom bilastinom, D − 

skupina tretirana antihistaminikom desloratadinom. 
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Slika 25. Izražaj neuroplastina 65 u slušnoj kori mužjaka i ženki Sprague Dawley štakora. 

Podaci su statistički analizirani dvosmjernim ANOVA testom uz Tukeyjev post hoc. BM − 

mužjaci intrauterino tretirani antihistaminikom bilastinom, BŽ − ženke intrauterino tretirane 

antihistaminikom bilastinom, DM − mužjaci intrauterino tretirani antihistaminikom 

desloratadinom, DŽ − ženke intrauterino tretirane antihistaminikom desloratadinom, IDV − 

vrijednost integrirane gustoće (engl. integrated density value), KM − kontrolna skupina 

mužjaka, KŽ − kontrolna skupina ženki. 

Izražaj neuroplastina 65 u CA3 području hipokampusa 

 Na temelju kvantifikacije imunopozitivnih stanica na Np65 (Slika 26) provedena je 

analiza izražaja navedenog receptora u CA3 području hipokampusa Sprague Dawley štakora 

dvosmjernim ANOVA testom koja je otkrila statistički značajan rezultat. Statistički su značajni 

učinci tretmana F(2,35) = 10,87, p = 2,8×10-4, spola F(1,35) = 37,62, p = 9,6×10-7 te njihove 

interakcije F(2,35) = 4,318, p = 0,023 (Slika 27). Kod skupina tretiranih bilastinom i 

desloratadinom ima značajno manje Np65 u odnosu na kontrolne skupine. Također, Tukeyjev 

post hoc test otkriva da su statistički značajno manji izražaj Np65 u CA3 području imale 

skupine BM (p = 0,0016) i DM (p = 2,4×10-4)u odnosu na KM. Kod ženki nije bilo tako 

drastičnih promjena. 
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Slika 26. Imunohistokemijski prikazi CA3 područja hipokampusa mužjaka i ženki Sprague 

Dawley štakora testiranih protutijelom na neuroplastin 65. Povećanje 200×. S lijeva na desno: 

Neg − negativna kontrola, K − kontrolna skupina, B − skupina tretirana antihistaminikom 

bilastinom, D − skupina tretirana antihistaminikom desloratadinom. 

 

Slika 27. Izražaj neuroplastina 65 u CA3 području hipokampusa mužjaka i ženki Sprague 

Dawley štakora. Podaci su statistički analizirani dvosmjernim ANOVA testom uz Tukeyjev 

post hoc. BM − mužjaci intrauterino tretirani antihistaminikom bilastinom, BŽ − ženke 

intrauterino tretirane antihistaminikom bilastinom, DM − mužjaci intrauterino tretirani 

antihistaminikom desloratadinom, DŽ − ženke intrauterino tretirane antihistaminikom 

desloratadinom, IDV − vrijednost integrirane gustoće (engl. integrated density value), KM − 

kontrolna skupina mužjaka, KŽ − kontrolna skupina ženki. 
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Izražaj neuroplastina 65 u području dentatnog girusa hipokampusa 

 Na temelju kvantifikacije imunopozitivnih stanica na Np65 (Slika 28) provedena je 

analiza izražaja navedenog receptora u području dentatnog girusa hipokampusa Sprague 

Dawley štakora dvosmjernim ANOVA testom. Analiza je pokazala da je statistički značajan 

samo učinak spola F(1,17) = 22,22, p = 0,0005 (Slika 29). Ženke pokazuju veći izražaj Np65 u 

odnosu na mužjake. Učinci tretmana te interakcije spola i tretmana nisu bili statistički značajni. 

 

Slika 28. Imunohistokemijski prikazi područja dentatnog girusa hipokampusa mužjaka i ženki 

Sprague Dawley štakora testiranih protutijelom na Np65. Povećanje 200×. S lijeva na desno: 

Neg − negativna kontrola, K − kontrolna skupina, B − skupina tretirana antihistaminikom 

bilastinom, D − skupina tretirana antihistaminikom desloratadinom. 
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Slika 29. Izražaj neuroplastina 65 u području dentatnog girusa hipokampusa mužjaka i ženki 

Sprague Dawley štakora. Podaci su statistički analizirani dvosmjernim ANOVA testom uz 

Tukeyjev post hoc. BM − mužjaci intrauterino tretirani antihistaminikom bilastinom, BŽ − 

ženke intrauterino tretirane antihistaminikom bilastinom, DM − mužjaci intrauterino tretirani 

antihistaminikom desloratadinom, DŽ − ženke intrauterino tretirane antihistaminikom 

desloratadinom, IDV − vrijednost integrirane gustoće (engl. integrated density value), KM − 

kontrolna skupina mužjaka, KŽ − kontrolna skupina ženki. 

Izražaj neuroplastina 65 u jezgri substantia nigra srednjeg mozga 

 Na temelju kvantifikacije imunopozitivnih stanica na Np65 (Slika 30) provedena je 

analiza izražaja navedenog receptora u SNR području srednjeg mozga Sprague Dawley štakora 

dvosmjernim ANOVA testom. Analiza je pokazala da je statistički značajan učinak spola u 

ovom području F(1,17) = 7,044, p = 0,021 (Slika 31). Ženke pokazuju veći izražaj Np65 u odnosu 

na mužjake. Učinci tretmana te interakcije spola i tretmana nisu bili statistički značajni.  
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Slika 30. Imunohistokemijski prikazi jezgre substantia nigra srednjeg mozga mužjaka i ženki 

Sprague Dawley štakora testiranih protutijelom na neuroplastin 65. Povećanje 200×. S lijeva na 

desno: Neg − negativna kontrola, K − kontrolna skupina, B − skupina tretirana 

antihistaminikom bilastinom, D − skupina tretirana antihistaminikom desloratadinom. 

 

Slika 31. Izražaj neuroplastina 65 u jezgri substantia nigra srednjeg mozga mužjaka i ženki 

Sprague Dawley štakora. Podaci su statistički analizirani dvosmjernim ANOVA testom uz 

Tukeyjev post hoc. BM − mužjaci intrauterino tretirani antihistaminikom bilastinom, BŽ − 

ženke intrauterino tretirane antihistaminikom bilastinom, DM − mužjaci intrauterino tretirani 

antihistaminikom desloratadinom, DŽ − ženke intrauterino tretirane antihistaminikom 

desloratadinom, IDV − vrijednost integrirane gustoće (engl. integrated density value), KM − 

kontrolna skupina mužjaka, KŽ − kontrolna skupina ženki. 
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Izražaj neuroplastina 65 u tuberomamilarnoj jezgri hipotalamusa 

 Na temelju kvantifikacije imunopozitivnih stanica na Np65 (Slika 32) provedena je 

analiza izražaja navedenog receptora u TMN jezgri hipotalamusa Sprague Dawley štakora 

dvosmjernim ANOVA testom. Analiza je pokazala da je statistički značajan učinak spola F(1,17) 

= 4,803, p = 0,049 (Slika 33). Ženke pokazuju veći izražaj Np65 u odnosu na mužjake. Učinci 

tretmana te interakcije spola i tretmana nisu bili statistički značajni. 

 

Slika 32. Imunohistokemijski prikazi tuberomamilarne jezgre hipotalamusa mužjaka i ženki 

Sprague Dawley štakora testiranih protutijelom na neuroplastin 65. Povećanje 200×. S lijeva na 

desno: Neg − negativna kontrola, K − kontrolna skupina, B − skupina tretirana 

antihistaminikom bilastinom, D − skupina tretirana antihistaminikom desloratadinom. 
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Slika 33. Izražaj neuroplastina 65 u tuberomamilarnoj jezgri hipotalamusa mužjaka i ženki 

Sprague Dawley štakora. Podaci su statistički analizirani dvosmjernim ANOVA testom uz 

Tukeyjev post hoc. BM − mužjaci intrauterino tretirani antihistaminikom bilastinom, BŽ − 

ženke intrauterino tretirane antihistaminikom bilastinom, DM − mužjaci intrauterino tretirani 

antihistaminikom desloratadinom, DŽ − ženke intrauterino tretirane antihistaminikom 

desloratadinom, IDV − vrijednost integrirane gustoće (engl. integrated density value), KM − 

kontrolna skupina mužjaka, KŽ − kontrolna skupina ženki. 
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6. RASPRAVA 

 Histamin je kemijski glasnik imunološkog sustava, ali i važan neurotransmiter 

središnjeg živčanog sustava kralježnjaka (1). Premda su antihistaminici lijekovi koji se koriste 

za liječenje alergijskih poremećaja, imaju ulogu u gastrointestinalnim i neurološkim 

poremećajima (10). Prvu generacija antihistaminika čine kompetitivni inhibitori histamina koji 

djeluju na H1 receptorsko mjesto na ciljnim stanicama u sluznici respiratornog sustava. Vrlo su 

lipofilni pa prolaze BBB gdje blokiraju H1 receptorska mjesta u mozgu te izazivaju sedacijski 

učinak (11). Druga generacija antihistaminika razvijena je kako bi se smanjila ili potpuno 

eliminirala sedacija i štetni antikolinergički učinci koji se javljaju kod starijih antagonista H1 

receptora. Lijekovi iz ove generacije relativno su lipofobni i imaju mali volumen distribucije te 

slabije prolaze kroz BBB (13). Svaki lijek upotrijebljen u trudnoći nosi rizik od teratogenosti i 

prije toga treba pažljivo procijeniti rizik / korist od propisivanja (16). H1 antihistaminici koriste 

se za liječenje mučnina i povraćanja tijekom trudnoće koje se javljaju u otprilike 85 % trudnoća, 

i to najčešće u prvom tromjesečju (18). Ako je lijek korišten u prvom tromjesečju, može 

uzrokovati strukturalne fetalne malformacije i u kasnijem dijelu trudnoće mogu uslijediti razni 

funkcionalni defekti. Stoga se u trudnoći nastoje izbjeći konzumacije bilo kakvih lijekova te 

liječnici važu prednosti u odnosu na potencijalne teratogene učinke prije korištenja bilo kojeg 

lijeka u trudnoći (16). 

 Na temelju histološkog bojenja po Nisslu izradili smo prikaze anatomije mozga 

proučavanih skupina štakora. Skupine tretirane antihistaminicima bilastinom i desloratadinom 

pokazale su promjene u anatomiji hipokampusa na način da njihov hipokampus pokazuje 

„nabrani“ izgled, odnosno ima vijugav oblik. Uspoređujući tretirane skupine s kontrolnim 

skupinama, možemo vidjeti da takav izgled nije uobičajen u hipokampusu kontrolnih skupina 

mužjaka i ženki. Možemo pretpostaviti da je tretman antihistaminicima uzrokovao navedene 

promjene, no ova pretpostavka iziskuje dodatnu potvrdu. 

 Na temelju imunohistokemijskog bojenja NeuN-a i histološkog bojenja po Nisslu 

analizirana je debljina i određen udio slojeva moždane kore primarnog slušnog i motoričkog 

područja. U slušnom području nije bilo statistički značajne razlike u udjelima slojeva 1 i 4. No, 

u usporedbi s kontrolnom skupinom, ženke su pokazale veći udio slojeva 2 i 3 u odnosu na 

mužjake što nam govori kako je u ovom sloju učinak spola imao statistički značajan utjecaj. 

Učinak spola također je statistički značajno utjecao na udio slojeva 5 i 6 tako da su skupine 

mužjaka imale veći udio u odnosu na skupine ženki. Svaki podražaj koji dolazi iz talamusa 
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ulazi prvo u sloj 4, zatim projekcije idu prema slojevima 2 i 3 gdje se prispjele informacije 

dodatno obrađuju. Iz slojeva 2 i 3 projekcije idu prema suprotnoj hemisferi ili u susjedne regije 

moždane kore, ali dio projekcija ide prema slojevima 5 i 6, a odavde prema subkortikalnim 

ciljevima (48, 49). Razlika u debljini slojeva kod mužjaka i ženki mogla bi biti podloga razlici 

u obrađivanju slušnih i motoričkih podražaja koje bi se mogle utvrditi bihevioralnim testovima. 

Ranije su opisane spolne razlike u izgledu mozga pa su tako Qiu i suradnici u istraživanju na 

miševima pokazali da se mozak mužjaka u ranoj dobi razvija brže u odnosu na mozak ženki što 

je povezano s razlikom u razinama hormona. Za razvoj muškog mozga ključna je rana 

izloženost visokim koncentracijama testosterona koji se na BBB pretvara u estradiol, a koji je 

ključan u seksualnoj diferencijaciji mozga. Istovremeno se mozak ženki razvija bez utjecaja 

estrogena u ranoj fetalnoj dobi jer je ovaj blokiran alfa-fetoproteinom pa će do konačne 

diferencijacije pod utjecajem estrogena doći tijekom adolescencije (50). Rabinowicz i suradnici 

u istraživanju na ljudskom mozgu pokazali su razlike u strukturi moždane kore između 

muškaraca i žena. Moždana kora muškaraca ima veću neuronsku gustoću s manje neuropila po 

neuronu i kao takva može poboljšati fokus i specifičnost funkcija moždane kore. Suprotno 

tome, veći opseg neuropila ženskog mozga po neuronu može poboljšati integraciju informacija 

iz različitih izvora (51). Dakle, naši rezultati prikaz su normalnog stanja moždane kore u 

promatranoj dobi. 

 Analizom slojeva u M1 području moždane kore dvosmjerni ANOVA test otkrio je da 

na udio slojeva 1, 2 i 3 tretman nema statistički značajnih učinaka. Statistički značajan utjecaj 

na udio sloja 4 pokazala je interakcija intrauterinog tretmana i spola i to na način da su mužjaci 

iz skupine B imali statistički značajno manji udio sloja 4 u odnosu na kontrolnu skupinu te 

skupinu B ženki. Ovaj rezultat govori nam kako mužjaci tretirani antihistaminikom bilastinom, 

za razliku od ženki, nisu na isti način obrađivali informacije koje stižu iz talamusa u sloj 4. 

Učinak tretmana pokazao je statistički značajnu razliku na udio slojeva 5 i 6. Skupine mužjaka 

i ženki tretirane antihistaminikom bilastinom imale su značajno manji udio spomenutih slojeva 

u odnosu na kontrolnu skupinu što upućuje na mogućnost razlike u snazi subkortikalnih 

projekcija promatranih skupina. Kako je primarno motorno područje ključna struktura za 

aktivnost voljnih pokreta i za učenje motornih vještina potrebno je pobliže istražiti ove 

promjene bihevioralnim testovima (52). Naime, još nije provedeno istraživanje ovog tipa pa 

nema podataka s kojima bismo mogli usporediti naše rezultate, stoga bi u budućnosti trebalo 

provesti detaljnije istraživanje utjecaja bilastina na primarna osjetna područja moždane kore. 
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 Imunohistokemijskim bojenjem glijalnog fibrilarnog kiselog proteina (GFAP) 

vizualizirali smo astrogliju, a tijela neurona već spomenutim bojenjem NeuN te smo izračunali 

i usporedili omjer neurona i astroglije u Au1 i M1 područjima moždane kore eksperimentalnih 

skupina u odnosu na kontrolnu. Analiza dvosmjernim ANOVA testom pokazala je kako 

antihistaminici povećavaju omjer NeuN/GFAP u Au1 području što znači da se povećava udio 

neurona, a smanjuje udio glije, što je vidljivo na imunohistokemijskim prikazima preparata i 

pratećim kvantifikacijama (slike 10 i 11). Ovaj rezultat ne znači nužno kako se broj GFAP 

pozitivnih stanica u mozgu štakora smanjio, već može biti odraz povećanja broja neurona u 

odnosu na gliju čiji je izražaj ostao isti i nakon intrauterine primjene antihistaminika. Nadalje, 

rezultat je neobičan s obzirom da bilastin i desloratadin pripadaju antihistaminicima druge 

generacije i klasificirani su kao antihistaminici koji ne prelaze BBB (53). Usporedbom omjera 

u M1 području moždane kore test je pokazao kako nema statistički značajnih rezultata. 

 Analiza izražaja H1R pokazala je kako učinci spola, tretmana te interakcije spola i 

tretmana nisu bili statistički značajni u Au1 području moždane kore. No, pokazalo se kako je 

tretman desloratadinom povećao izražaj H1R u CA3 području hipokampusa u odnosu na 

kontrolnu skupinu. Također, međusobno se statistički značajno razlikuju skupine tretirane 

bilastinom od kontrolne te postoji statistički značajna razlika unutar skupina B i D kao i 

uspoređujući ih međusobno. U DG području učinak interakcije tretmana i spola bio je statistički 

značajan uzrokujući povećanje izražaja H1R u skupini mužjaka tretiranoj antihistaminikom 

bilastinom. Također, statistički se međusobno razlikuju skupine mužjaka tretiranih bilastinom 

od skupina ženki tretiranih bilastinom. Nadalje, dvosmjerni ANOVA test pokazao je statistički 

značajnu razliku u SNR području moždane kore između skupina tretiranih antihistaminikom 

bilastinom u odnosu na kontrolne skupine. U TMN jezgri pokazalo se da tretman 

desloratadinom izaziva povećanje izražaja H1R kod ženki u odnosu na kontrolnu skupinu. 

Statistički se značajno razlikuju i skupina mužjaka tretiranih antihistaminikom bilastinom u 

odnosu na kontrolnu skupinu mužjaka. Dobiveni rezultati nisu u skladu sa dosadašnjim 

istraživanjima. Primjerice, Nakamura i suradnici u svom istraživanju pokazali su kako se 

desloratadin ne veže značajno na H1R u mozgu (29). Također, Sanchez-Borges i Ansotegui 

pokazali su da bilastin uzrokuje neznačajnu H1R zauzetost u mozgu te kako nema utjecaja na 

središnji živčani sustav (54). Korisno bi bilo provesti novo istraživanje koje će se temeljiti na 

detaljnijem proučavanju utjecaja antihistaminika bilastina i desloratadina na izražaj H1R u 

područjima moždane kore koja su istraživana u ovom radu. 
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Imunohistokemijskim bojenjem na Np65 analizirali smo izražaj navedenog receptora te 

zaključili kako je statistički značajan rezultat pokazao samo učinak spola u područjima Au1, 

DG, SNR i TMN. Ženke su pokazale veći izražaj Np65 u odnosu na mužjake. Dvosmjerni 

ANOVA test utvrdio je da su statistički značajni učinci tretmana, spola te interakcije spola i 

tretmana u CA3 području moždane kore. Međusobno se statistički razlikuju kontrolna skupina 

mužjaka i skupina mužjaka tretirana bilastinom, kao i skupina mužjaka tretiranih 

desloratadinom u odnosu na kontrolnu skupinu. Kod skupina mužjaka tretiranih 

antihistaminicima ima značajno manje Np65 u odnosu na kontrolnu skupinu. Kako je Np65 

bitan transmembranski glikoprotein jer regulira nastanak, održavanje i plastičnost sinapsi, kao 

i kognitivne funkcije poput pamćenja i osjećaja, svako smanjenje njegova izražaja može imati 

negativne posljedice (41-43). Tako su Li i suradnici proveli istraživanje na miševima s 

isključenim genom za Np65 i došli do spoznaje da nedostatak Np65 uzrokuje emocionalne i 

kognitivne poremećaje (55). Hu i suradnici su pak pokazali da isti miševi imaju veću 

vjerojatnost ishemije u mozgu (56). Skupine ženki tretiranih antihistaminicima nisu pokazale 

tako drastične promjene u CA3 području. 

Uzimajući u obzir rezultate ovog istraživanja može se zaključiti kako antihistaminici 

bilastin i desloratadin djeluju na razvoj neurona i glije, kao i na izražaj H1R te sinaptogenezu. 

No, kako je ovo istraživanje prvo koje istražuje utjecaj navedenih antihistaminika kod 

potomaka tretiranih štakorica na proučavana područja u mozgu, nema prikladne literature s 

kojom bismo usporedili dobivene rezultate. Budući da se rezultati kose sa spoznajom kako 

antihistaminici druge generacije ne prelaze BBB i time ne uzrokuju promjene u mozgu, treba 

provesti dodatna istraživanja te odrediti točan mehanizam djelovanja istih na ispitivana 

područja. Korisno bi bilo u naredna istraživanja uključiti veći broj Sprague Dawley štakorica 

koje će biti tretirane bilastinom i desloratadinom jer bi time dobili veći uzorak i objektivnije 

rezultate što je od velike važnosti za sve trudnice koje će koristiti jedan od navedenih 

antihistaminika. Treba pažljivo proučiti i procijeniti rizike kako ne bi došlo do negativnih i 

nepovratnih posljedica. 
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7. ZAKLJUČAK 

 

Provedeno istraživanje i dobiveni rezultati dovode do sljedećih zaključaka: 

1. Skupine životinja tretirane antihistaminicima bilastinom i desloratadinom pokazale su 

promjene u anatomiji hipokampusa. 

2. Nije bilo statistički značajne razlike na udio slojeva moždane kore u Au1 području. 

Skupine tretirane antihistaminikom bilastinom pokazale su statistički značajnu razliku 

u udjelima slojeva 4, 5 i 6 u M1 području moždane kore. 

3. Analizom omjera neurona i glije u Au1 području moždane kore utvrđeno je kako 

antihistaminici povećavaju omjer NeuN/GFAP. U M1 području nema statistički 

značajnih promjena. 

4. Antihistaminici povećavaju izražaj H1R u CA3, DG, SNR i TMN područjima, no u Au1 

području nema statistički značajne promjene. 

5. Tretman antihistaminicima uzrokuje smanjenje izražaja Np65 u CA3 području 

hipokampusa, dok u područjima Au1, DG, SNR i TMN nema značajnih promjena. 
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8. SAŽETAK 

 

Cilj istraživanja: Usporediti tri skupine potomaka netretiranih majki ili majki tretiranih 

antihistaminicima s obzirom na izražaj H1 receptora, markere neurona i glije te neuroplastin 

kao marker sinaptogeneze. 

Nacrt studije: U studiju je uključeno 36 životinja starosti 3 mjeseca. Životinje su podijeljene 

u 3 skupine: 1. potomci netretiranih Sprague Dawley štakorica (kontrola), 2. potomci štakorica 

tretiranih desloratadinom, 3. potomci štakorica tretiranih bilastinom. 

Materijali i metode: Histološkom bojom krezil violet prikazali smo jezgre stanica u mozgu te 

tako razaznali slojeve mozga. Imunohistokemijski, pomoću visokospecifičnih protutijela na H1 

receptor, neuronski jezgrin protein, glijalni fibrilarni kiseli protein te neuroplastin 65, prikazali 

smo navedene epitope u tkivu mozga. 

Rezultati: Postoji statistički značajna razlika u izražaju H1R i Np65 u pojedinim područjima 

mozga štakora, zatim u udjelima slojeva u M1 području te u omjeru NeuN/GFAP u Au1 

području moždane kore. Također, tretirane skupine pokazuju promjene u anatomiji 

hipokampusa. 

Zaključak: Antihistaminici bilastin i desloratadin djeluju na razvoj neurona i glije, izražaj H1R 

te sinaptogenezu u mozgu štakora. 

Ključne riječi: antihistaminici, histamin, mozak, trudnoća 
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9. SUMMARY 

Effect of desloratadine and bilastine antihistamines on brain development of Sprague Dawley 

rats 

 

Objectives: To compare three groups of cubs originating from untreated mothers or mothers 

treated with antihistamines with respect to H1 receptor expression, neuronal and glial markers, 

and neuroplastin as a marker of synaptogenesis. 

Study design: The study included 36 animals at the age of 3 months. Animals were divided 

into 3 groups: 1 offspring of untreated Sprague Dawley rats (control), 2 offspring of 

desloratadine-treated rats, 3 offspring of bilastine-treated rats. 

Material and methods: With the histological stain of cresyl violet we showed the cell nuclei 

in the brain and thus distinguished the layers of the brain. Immunohistochemically, using highly 

specific antibodies to the H1 receptor, neuronal nuclear protein, glial fibrillary acidic protein 

and neuroplastin 65, we presented these epitopes in brain tissue. 

Results: The results showed statistically significant differences in the expression of H1R and 

Np65 in individual areas of the rat brain, also in the proportions of layers in the M1 region and 

in the NeuN/GFAP ratio in the Au1 region of the cerebral cortex. Also, the treated groups show 

changes in the anatomy of the hippocampus. 

Conclusion: The antihistamines bilastine and desloratadine act on the development of neurons 

and glia, H1R expression and synaptogenesis in the rat brain. 

Keywords: antihistamines, histamine, brain, pregnancy 
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